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SAFETY INSTRUCTIONS

1.  Read these instructions. Keep these instructions. Follow all instructions. Heed
all warnings.

2. Do not use this unit near water.

3. Clean only with a dry cloth. Disconnect the MP3 player from the computer
before cleaning.

4. Do not block any ventilation openings. Install in accordance with
manufacturer’s instructions.

5. Do not install near any heat sources such as radiators, heat registers, stoves
or other apparatus (including amplifiers) that produce heat.

6.  Only use attachments/accessories specified by the manufacturer.

7. Disconnect the MP3 player from the computer during lightning storms or when
unused for long periods of time.

8.  Refer all servicing to qualified service personnel. Servicing is required when
the unit has been damaged in any way, such as the following: liquid has been
spilled or objects have fallen into the unit and/or the unit has been exposed to
rain or moisture, does not operate normally, has changed its performance or
has been dropped. Do not attempt to service this product yourself as opening
or removing covers may expose you to dangerous voltage or other hazards.

9. This unit should not be exposed to dripping or splashing water and no object
filled with liquids such as vases should be placed near the unit. Never push
objects of any kind into this unit through any openings.

10. Use replacement parts as specified by the manufacturer.

11. Upon completion of any service or repairs to this product, ask the service
technician to perform safety checks.

12. To avoid electric shock and malfunction, avoid using this device in a place far
from water or humidity.

13. Do not use this device in extreme temperatures, dust or humidity.

14. Never disassemble, attempt to fix or modify the device personally. That may
cause electric shock or void the warranty.

15.  Try not to drop the device. The surface of the device may get scratched or the
device may malfunction.

16. Please keep this device away from strong magnetic fields, such as televisions,
monitors or speakers, which may cause damage.

17. Never disconnect the device from the computer while it is transferring data
through the USB cable. If so, the data may be damaged.




SAFETY INSTRUCTIONS

FCC WARNING:

This equipment may generate or use radio frequency energy. Changes or modifications
to this equipment may cause harmful interference unless the modifications are expressly
approved in the instruction manual. The user could lose the authority to operate this
equipment if an unauthorized change or modification is made.

FCC INFORMATION:

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

+ Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

COPYRIGHT:
»  Distributing copies of MP3, WMA with DRM or WAV tracks without permission is a
violation of international copyright laws.

SAFETY:

»  Vibration experienced during walking or exercising will not affect the player. However,
dropping the player or dropping a heavy object on the player may result in damage
or sound distortion.

*  Avoid spilling any liquid onto or into the player.

» Do not leave the player in a location near heat sources; in a location subject to direct
sunlight, excessive dust, sand, moisture, rain or mechanical shock; on an unlevel
surface; or in a car with the windows closed during periods of excessive heat.

ROAD SAFETY:

+ Do not use headphones while driving, cycling or operating any motorized vehicle. It
may create a traffic hazard and it is illegal in some areas. It can be potentially
dangerous to play your headset at a high volume while walking, especially at
pedestrian crossings. You should exercise extreme caution or discontinue use in
potentially hazardous situations.



Dear Customer:

Selecting fine audio equipment such as the unit you've just purchased is only the start of
your musical enjoyment. Now it's time to consider how you can maximize the fun and
excitement your equipment offers. This manufacturer and the Electronic Industries
Association’s Consumer Electronics Group want you to get the most out of your equipment
by playing it at a safe level. One that lets the sound come through loud and clear without
annoying blaring or distortion and, most importantly, without affecting your sensitive
hearing. Sound can be deceiving. Over time your hearing “comfort level” adapts to higher
volumes of sound. So what sounds “normal” can actually be loud and harmful to your
hearing. Guard against this by setting your equipment at a safe level BEFORE your
hearing adapts.

To establish a safe level:

+ Start your volume control at a low setting.

» Slowly increase the sound until you can hear it comfortably and clearly, and
without distortion.

Once you have established a comfortable sound level:
+ Set the dial and leave it there.

Taking a minute to do this now will help to prevent hearing damage or loss in the future.
After all, we want you listening for a lifetime.

We Want You Listening For A Lifetime

Used wisely, your new sound equipment will provide a lifetime of fun and enjoyment. Since
hearing damage from loud noise is often undetectable until it is too late, this manufacturer
and the Electronic Industries Association’s Consumer Electronics Group recommend you
avoid prolonged exposure to excessive noise. This list of sound levels is included for
your protection.

Decibel
Level Example

30 Quiet library, soft whispers
40 Living room, refrigerator, bedroom away from traffic
50 Light traffic, normal conversation, quiet office
60 Air conditioner at 20 feet, sewing machine
70 Vacuum cleaner, hair dryer, noisy restaurant
80 Average city traffic, garbage disposals, alarm clock at two feet

THE FOLLOWING NOISES CAN BE DANGEROUS UNDER
CONSTANT EXPOSURE:

90 Subway, motorcycle, truck traffic, lawn mower

100 Garbage truck, chain saw, pneumatic drill

120 Rock band concert in front of speakers, thunderclap
140 Gunshot blast, jet engine

180 Rocket launching pad

Information courtesy of the Deafness Research Foundation.
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Emerson Radio Corp. has produced this audio product under
license from Mattel. We have taken great care to make sure your
unit was in perfect working order when it left our factory.

It has been designed to give you many years of enjoyment and
trouble-free operation. Read this manual before operating this unit
to become familiar with its features. In the event you require
technical assistance, please contact the Emerson Radio Customer
Service hotline at 1-800-898-9020. Retain this manual for
future reference.

D /| WARNING

Choking Hazard—Small Parts and Packaging Materials. Not for children

under 5 years.

» All materials for fastening or packing purposes are not part of the unit and
should be discarded for children’s safety.

» Please keep all information for future reference.

» This is not a toy.

NOTES:

* Please avoid using this unit in places of high temperature or
humidity over prolonged periods of time as damage may occur.

» Exposure to direct sunlight in places such as car interiors may
cause the unit to become warped and/or lead to malfunctioning.

* Avoid using or storing this unit in dusty or sandy locations.



ACCESSORIES INCLUDED

- (i

Main Unit Lanyard and Earbuds
SS, ( - )
USB Cable Installation CD

Quick Start Guide



CONOO R WN =

LOCATION OF CONTROLS

Menu M1 Button

Display

Lanyard Hole

RESET Access (Bottom of Unit)
Hold @ Switch

Skip/Search 4 Button
Headphones ) Jack
Play/Pause »11/Power Button
Skip/Search W Button

. GEMSTONE FUN (Record) Button

. Volume - Button

. USB <+ Jack (Side of Unit, Under Cover)
. Volume + Button

. MIC (Microphone)



POWER SOURCE

RECHARGEABLE BATTERY OPERATION

This unit comes with a built-in Lithium lon rechargeable battery. It is
recommended that the battery be fully charged before using for the first time.
When the battery indicator at the top right of the display becomes empty,
recharge the battery. Below are the icons which will display the rechargeable
battery status:

(T T e T

FULL 50% EMPTY

TO CHARGE THE BATTERY WITH YOUR COMPUTER

1. Connect the USB Cable to the USB port on the computer; connect the
cable to the USB port on the MP3 player. Press the Play/Pause »11/Power
button; the battery indicator at the top right of the display will blink to
indicate it is being charged.

2. When the battery is fully charged, the battery indicator will be full.

AT

USB «<- jack

USB cable ?
Computer

NOTES:

*  The unit must be charged for four hours for the first time. Subsequent
charges will take approx. 2-3 hours.

*  When fully charged, the unit can playback for approx. 16 hours when the
backlight screen is turned off.



USING THE LANYARD

TO ATTACH THE LANYARD

R

Insert the cord through the Lanyard hole.

Loop the cord around the locking piece and pull until tightened.

DOWNLOADING AND TRANSFERRING FILES

SUPPORTED OPERATING SYSTEMS
This unit is compatible with the following Operating Systems:
Windows ME, 2000, XP and Vista or Mac 10.2.6 or higher

Please refer to the following pages to learn how to:

 transfer files

» convert music on an audio CD into MP3 or WMA format using
Windows Media Player 10

» transfer MP3/WMA files and WMA files with DRM 9 or 10 using
Windows Media Player 10

» safely remove your unit from the computer.

NOTE: Visit www.Microsoft.com to download the corresponding
Windows Media Player for your computer.



DOWNLOADING AND TRANSFERRING FILES (CONT.)

TRANSFERRING FILES

You can download digital music files from the Internet or use encoding

software to convert music that you have on an audio CD into MP3 or

WMA format. Once these files are stored on your computer you can

easily copy them to your player.

For Windows XP, if you have Windows Media Player 10, you can

transfer music files (MP3, WMA, WMA files with DRM 9 or 10) to the

player through the

"Sync"  function of

Windows Media Player

10. Connect this unit to

the USB port on your

computer using the USB cable

USB cable. “MTP Computer

Player” will appear in your "My Computer" folder which indicates the

player is connected. Then, follow the procedure on page 12 to transfer

music files to the player.

For Windows ME, 2000, Vista or Windows XP (without Windows

Media Player 10), transfer music files as follows:

1. Connect your player to the USB port on your computer using the USB
cable as shown above.

2. A "Removable Disk" window will automatically pop-up on your
computer screen.

3. To add more files and songs to your player, simply drag and drop
MP3 or WMA files/folders from anywhere on your computer into the
"Removable Disk" window.

IMPORTANT: A WMA file with DRM 9 or 10 will not play back if you

directly drag and drop it into the "Removable Disk" window. You must use

Windows Media Player 10 to transfer copy-protected files as described

on page 12.




DOWNLOADING AND TRANSFERRING FILES (CONT.)

TRANSFERRING AUDIO FILES TO YOUR DIGITAL AUDIO PLAYER USING
A MAC COMPUTER

Make sure to use a Mac computer with an operating system of 10.2.6 or higher
to transfer audio files.

1. Turn on your computer.

2. Turn on your digital audio player.

3. Connect the smaller end of the cable to the USB jack on the player and the
larger end of the cable to the USB port on your Mac.

4. Your computer will automatically recognize your player and mount a hard
disk icon onto your desktop.

5. Locate the folder where your audio files are stored on your computer’s
hard drive. Simply drag and drop the audio files onto the mounted hard
disk drive icon of your digital audio player located on your desktop.

6. After you have finished your transfer, put away the digital audio player hard
disk icon(s) by: dragging it to the Trash icon; Control-clicking its icon and
choosing Eject from the File menu; selecting Eject from the File drop-down
menu located at the top of your screen; or, by using the keyboard shortcuts
by selecting the digital audio player hard disk icon and pressing the
Command-E keys.

7. Your player is ready to play the files you transferred.
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DOWNLOADING AND TRANSFERRING FILES (CONT.)

For Windows XP, you can also utilize
Windows Media Player 10 software to
convert music on an audio CD into MP3 or
WMA format as follows:

1. Open the Windows Media Player 10
Browser, then click on the “Rip” icon
on the top tool bar. Insert a Music CD
into the CD-Rom drive of
your computer.

NOTE: For Windows ME, 2000 or Vista,

please use the corresponding Windows

Media Player for your computer to convert
music on an audio CD into MP3 or options __________X]

WMA format.

2. Click on the “Tools” menu option at the top
menu bar, then click on “Options”; the Option
setting menu will appear. Click on Rip Music
and set the Rip Music to the desired location
on your computer. Then, set the desired
format for the newly ripped music (MP3 format s
or Windows Media Audio format). Adjust the s jp— =
audio quality as desired. When finished, click

“OK” to confirm the settings.

PaEvET——

ings.

Uses about 28 B per CD (64 Kbps).

ecia ucio o cthet formals

3. Click on the “Rip Music” icon to start ripping

the music to your computer.

4. When the music tracks are ripped; connect the player to your computer. Open the
“Removable Disk” window and open the ripped music location window.

5. To add the transferred/ripped music files/songs to your player simply drag and
drop the MP3 and/or WMA files into the “Removable Disk” window.

6. When the files are finished loading into the player, you can follow the “Safely
Remove Hardware” procedure as shown on page 13.
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DOWNLOADING AND TRANSFERRING FILES (CONT.)

TRANSFERRING MP3/WMA FILES AND WMA FILES WITH DRM 9 or 10
USING WINDOWS MEDIA PLAYER 10 (FOR WINDOWS XP ONLY)

To transfer MP3 files/WMA files/WMA files with DRM 9 or 10 to the player,
follow the procedure described below using Windows Media Player 10.
Before beginning the procedure please turn the unit on and connect the unit

to the computer

described.

1. Open the “Windows Media
Player Browser 10” and click
on “Sync”.

2. Click on the “Sync List”
down menu to locate the music
files you wish to download. Then
make sure to tick the box next to
the files.

3. Select the Portable Device
(“MTP Player”) that you want to
copy to from the right side drop-
down menu. Click “Start Sync” to
start transferring music files to
the player.

4. After finished transferring all the
desired files to your unit, you can
remove your unit from
the computer.

as previously

NOTE: There will be two folders,
Data and Media, within “MTP
Player”. The music files can be
downloaded to any folder. But make
sure to download photos to the folder
named Photo within the Data folder.
Otherwise, you will not be able to
view your photos on this unit.

pull- |

s - ,m‘

foreo O Wa
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SAFELY REMOVE HARDWARE

SAFELY REMOVING YOUR PLAYER FROM THE COMPUTER

(FOR WINDOWS ME OR 2000)

NOTE: To avoid damage to your player or data loss, always follow the procedure
listed below before disconnecting your player from the USB port on
your computer. ——

Using your mouse, double click the "Safely J 20 EeBuss
Remove Hardware" icon on the task bar.

'Safely Remove Hardware' icon
From the "Safely Remove Hardware" window (shown
lower right), select "USB Mass Storage Device" and |
click the "Stop" button. The "Stop a Hardware Device" | *
window will pop-up. Click "OK". When the "Safe to |'&iiimone
Remove Hardware" window is displayed, you may
remove the player from the USB cable or remove the
USB cable from the computer.

2|

g cx st and ek St Wren
o =5 npli the devis o yxs

U58 Mass Storage Devie o <USE FRODUCT>

NOTE: ==
* If the “Safely Remove Hardware” icon is not| “*~™ .
displayed on the task bar, please double-click on My
Computer. Right-click on “Removable Disk” and left-click on “Eject”. Then it is
safe to remove the player from the computer.

If you are using Windows XP and Windows Media Player 10 software is already
installed, then you do not need to follow the above "Safely Remove Hardware"
procedure.
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PERATION

TURNING THE POWER ON/OFF

Turn the unit on by pressing the Play/Pause
»11/Power button; the Barbie opening screen will
appear in the display temporarily. Then the menu
will appear in the display. To turn the unit off, press
and hold the Play/Pause »11/Power button; a
Barbie screen will appear in the display and the unit
will turn off.

HOLD a SWITCH

n "»*

With the unit on, slide the HOLD switch to the Lock
position (right); a small Lock icon @ will appear in
the display and no buttons will function. This is
useful when you do not want the track changed by
accidentally pressing a button. Slide the HOLD
switch to the Unlock position (left) to cancel the
Lock function.

NOTE: You will not be able to turn the unit on or off if the Hold feature
is activated.
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OPERATION (CONTINUED)

NAVIGATING THE MENUS

With the unit on (see page 14), use the
Skip/Search W @ or 44 @ button to navigate
through the menus (i.e, in the Main Menu,
select between Music, Record, Voice,
Photo, Settings or About). Then, press the
Play/Pause »11/Power button ® to confirm.

Press the Menu Mt putton @ repeatedly to
return to the previous/Main menu.
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OPERATION (CONTINUED)

TO LISTEN TO MP3s/WMAs

o List
o Play Mode
o Equalizer

With the unit on (see page 14), use
the Skip/Search W @ or 4 @ button
to navigate to Music, followed by
the Play/Pause »11/Power button
® to confirm.

Press the Play/Pause »l1l/Power
button @ to start playback.

Press the Volume + ® or - ®
buttons to increase or decrease
the volume.

NOTE: See pages 9-12 for
information on uploading MP3 and
WMA files to this unit.

TO PAUSE PLAYBACK

During playback, if you wish to
pause the file momentarily, press
the Play/Pause »11/Power button;
playback will pause and the timer
will stop counting.

Press the Play/Pause »l1l1/Power
button again to resume playback;
the sound will return and the timer
will start counting again.
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OPERATION (CONTINUED)

TO SELECT/BROWSE THROUGH THE FILES

o Music

o Play Mode

With the unit on (see page 14), use
the Skip/Search W @ or K4 @ button
to navigate to Music, followed by
the Play/Pause »11/Power button
® to confirm.

Use the Skip/Search M @ or ( ©
button to navigate to List, followed
by the Play/Pause »Il/Power
button @ to confirm.

Use the Skip/Search M @ or ( ®
button to navigate to the desired
file, followed by the Play/Pause
»11/Power button ® to confirm; a
pop-up menu will appear.

Select the desired option from the pop-
up menu: Play (to begin playback),
Delete (to delete your selection) or
Cancel (to cancel your selection) by
pressing the Skip/Search W @ or (@
button, followed by the Play/Pause
»11/Power button ® to confirm.

NOTE: If you select "Delete", you can
then select "Yes", "No" or "Cancel" by
pressing the Skip/Search W or 1«
button, followed by the Play/Pause
»11/Power button to confirm.
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OPERATION (CONTINUED)

SETTING THE PLAY MODE

o Music
o List

With the unit on (see page 14), use
the Skip/Search W @ or (@ button
to navigate to Music, followed by
the Play/Pause »11/Power button
® to confirm.

Use the Skip/Search W @ or ( ®
button to navigate to Play Mode,
followed by the Play/Pause »Il/
Power button & to confirm.

Use the Skip/Search W @ or 1 ©
button to select the desired Play
Mode, followed by the Play/Pause
»11/Power button ® to confirm.

Normal: Normal playback

Repeat One: Repeats the current file

Repeat All:  Repeats all of the files

Shuffle: Randomly plays the
files once and then
stops

Shuffle All: Randomly plays all the

files repeatedly
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OPERATION (CONTINUED)

SETTING THE EQUALIZER

© Music
o List
o Play Mode

With the unit on (see page 14), use
the Skip/Search W @ or K4 ® button
to navigate to Music, followed by
the Play/Pause »l1l/Power button
® to confirm.

Use the Skip/Search M @ or [ ®
button to navigate to Equalizer,
followed by the Play/Pause »Il/
Power button & to confirm.

Use the Skip/Search W @ or K ®
button to select the desired Equalizer
setting (Normal, Rock, Jazz, Classical
or Pop) followed by the Play/Pause
»11/Power button @ to confirm.
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OPERATION (CONTINUED)

FORWARD/REVERSE SKIP

During playback, press the Skip/Search MW
button @ to advance the player to the beginning
of the next file. Press the Skip/Search M button
@ repeatedly to advance the player to higher-
numbered files.

During playback, press the Skip/Search 4
button ® to move the player back to the
beginning of the previous file. Press the
Skip/Search 44 button @ repeatedly to move the
player back to lower-numbered files.

HIGH-SPEED MUSIC SEARCH

During playback, press and hold the Skip/Search
M @ or 44 @ button to move the player forward or
backward within a file to locate a specific musical
passage. The player will move forward or
backward at high speed as long as the button is
held. When you release the button, normal
playback will resume.
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OPERATION (CONTINUED)

TO CREATE A VOICE RECORDING

With the unit on (see page 14), use
the Skip/Search W @ or K4 @ button
to navigate to Record, followed by
the Play/Pause »1l1/Power button
® to confirm.

Use the Skip/Search W @ or 4 @
button to navigate to Start Record,
followed by the Play/Pause w1/
Power button @ to confirm.

o Record

Start Record

NOTES:
Speak/sing into the MIC (microphone) on the bottom of the unit

while recording.

To stop recording, press the GEMSTONE FUN (Record) button.
You can also create a voice recording at any time without entering the
Record menu. Simply press and hold the GEMSTONE FUN (Record)

button, as shown on page 30.

The voice recording will be saved as a file named Vxxx.WAV (For
example, VO01.WAV) in the Voice folder.
The screen will display a message indicating the memory is full when no

memory is left.

21




OPERATION (CONTINUED)

SETTING THE RECORDING OPTIONS

With the unit on (see page 14), use
the Skip/Search M @ or 4 @ button
to navigate to Record, followed by
the Play/Pause »l1l1/Power button
® to confirm.

Press the Play/Pause »1l/Power
button to select Record.

=

© Start Record ’

FORMAT: Use the Skip/Search M
@ or 4 ® button to navigate to
Format, followed by the Play/Pause
»11/ Power button @ to confirm.

Use the Skip/Search W @ or 4 ®
button to select a Format option (IM
ADPCM, MS ADPCM or PCM),
followed by the Play/Pause »Il/
Power button @ to confirm.

RATE: Use the Skip/Search W @ or
K€ ® button to navigate to Rate,
followed by the Play/Pause »Il/
Power button & to confirm.

Use the Skip/Search W @ or (@
button to select a Rate option
(8000Hz, 16000Hz or 22050Hz),
followed by the Play/Pause »11/
Power button & to confirm.

NOTES:

* Press the Menu button repeatedly to exit the menus.
* A high record sampling frequency indicates a high quality in sound but
also an increase in memory usage.
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OPERATION (CONTINUED)

TO LISTEN TO A RECORDING

With the unit on (see page 14), use
the Skip/Search W @ or K4 @ button
to navigate to Voice, followed by the
Play/Pause »Il/Power button ©
to confirm.

Use the Skip/Search M @ or ( ®
button to navigate to the desired
file, followed by the Play/Pause
»11/Power button ® to confirm; a
pop-up menu will appear.

Select the desired option from the pop-
up menu: Play (to begin playback),
Delete (to delete your selection) or
Cancel (to cancel your selection) by
pressing the Skip/Search W @ or (@
button, followed by the Play/Pause
»11/Power button ® to confirm.

NOTE: If you select "Delete", you can
then select "Yes", "No" or "Cancel" by
pressing the Skip/Search W or 1«
button, followed by the Play/Pause
»11/Power button to confirm.
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OPERATION (CONTINUED)

TO VIEW PHOTOS-This unit supports JPEGs and BMPs.

With the unit on (see page 14), use
the Skip/Search M @ or 4 @ button
to navigate to Photo, followed by
the Play/Pause »Il/Power button
® to confirm.

Use the Skip/Search W @ or (@
button to select between Manual,
Slide Show and Thumbnail viewing
modes, followed by the Play/Pause
»11/Power button ® to confirm.

ZOOM IN/OUT

If you have selected Manual mode
in Step 2 above, you can zoom
in/out on your photos by pressing
the Volume + @ or - @ buttons.

While in Zoom mode, you can also
move your photo right and/or left by
pressing and holding the Skip/
Search W @ or 4 @ button, or up
and/or down by pressing and holding
the Volume + ® or - @ buttons.

NOTE: Photos must be saved in the Photo folder. Otherwise, you will not be
able to view them. If this unit is recognized as a “MTP Player” by your
computer, the Photo folder can be found in the Data folder; see page 12.
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OPERATION (CONTINUED)

SETTING THE BRIGHTNESS

With the unit on (see page 14), use
the Skip/Search M @ or 4 @ button
to navigate to Settings, followed by
the Play/Pause »Il/Power button
® to confirm.

Press the Play/Pause »Il1/Power
button to select Brightness.

© Screen Saver

© Power Savings
© Photo Slide Time
© Default

Use the Skip/Search W @ or ( @
button to select a brightness level
between Low, Mid and High,
followed by the Play/ Pause
»11/Power button @ to confirm.

NOTE:

» Press the Menu button repeatedly to exit the menus.

25




OPERATION (CONTINUED)

SETTING THE SCREEN SAVER

With the unit on (see page 14), use
the Skip/Search M @ or 4 @ button
to navigate to Settings, followed by
the Play/Pause »1l1/Power button
® to confirm.

Use the Skip/Search M @ or 4 ®
button to select SCREEN SAVER,
followed by the Play/Pause
»11/Power button ® to confirm.

il

o Brightness
(" Scresn Save

o Power Savings

© Photo Slide Time |
© Default

Use the Skip/Search M @ or ( ®
button to select the desired screen
saver activation time (select OFF to
keep the screen light always on)
followed by the Play/Pause
»11/Power button ® to confirm.

NOTE:

» Press the Menu button repeatedly to exit the menus.
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OPERATION (CONTINUED)

SETTING THE POWER SAVINGS

With the unit on (see page 14), use
the Skip/Search W @ or K4 ® button
to navigate to Settings, followed by
the Play/Pause »l1l/Power button
® to confirm.

Use the Skip/Search M @ or [ ®
button to select Power Savings,
followed by the Play/Pause
»11/Power button ® to confirm.

o Brighiness

o Scroen Saver
("Power Savings |
© Photo Slide Time
o Default

Use the Skip/Search W @ or 4 ®
button to select the desired Power
Savings time (the unit will stay on
before turning off due to inactivity),
followed by the Play/Pause »I1l/
Power button  to confirm.

NOTES:

« Select OFF to disable this feature and not have the unit enter the Power

Savings mode.

» Press the Menu button repeatedly to exit the menus.
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OPERATION (CONTINUED)

SETTING THE PHOTO SLIDE TIME

With the unit on (see page 14), use
the Skip/Search M @ or 4 @ button
to navigate to Settings, followed by
the Play/Pause »1l1/Power button
® to confirm.

Use the Skip/Search M @ or 4 ®
button to select Photo Slide Time,
followed by the Play/Pause
»11/Power button ® to confirm.

© Brightness
© Screen Saver
o Power Savings:

Use the Skip/Search W @ or ( @
button to select the desired Photo
Slide time (will stay on the display
when in Slide Show mode),
followed by the Play/Pause
»11/Power button @ to confirm.

NOTE:

» Press the Menu button repeatedly to exit the menus.
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OPERATION (CONTINUED)

TO RESTORE DEFAULT SETTINGS TO VIEW THE SYSTEM INFO

Enter the Settings menu (see Step
1, previous page). Use the Skip/
Search M @ or 4 @ button to select
Default, followed by the Play/Pause
»1l/Power button ® to confirm; the
unit will restore the default settings

With the unit on (see page 14), use
the Skip/Search W @ or K4 @ button
to navigate to About, followed by
the Play/Pause »ll/Power button ®
to confirm. The Firmware Version,
Internal Media and Free Memory Space
will appear.

immediately.

NOTE: Press the Menu Ms button repeatedly to exit the menus.
FORMATTING THE PLAYER

WARNING! Do not format this player unless it stops working and you are instructed
to do so by technical support personnel.

To format this unit, connect it to your computer as previously described and use the
Windows format tool.

IMPORTANT:

» Do not select NTFS from the File System menu. If you do, the MP3 Player will
not work and will need to be formatted again.

» Please back-up the files on this unit before formatting.

UPDATING THE FIRMWARE

WARNING! Do not update the firmware unless you are experiencing
problems with your digital audio device. Incorrect or faulty firmware
installation will cause the player to stop functioning.

You can download the updated firmware:
www.emersonradio.com/BAR900/Update

RESETTING THE UNIT

If the unit acts erratically, reset the unit by inserting a thin object (such as a
paper clip) into the recessed RESET Access. See page 6 for the Reset
hole's location.
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OPERATION (CONTINUED)

See what you
can do with

Barbie™
Just follow the instructions below and

see what you can do with your
GEMSTONE FUN button!

has a surprise just for you!

%Step 2

You can record
yourself singing or
speaking into your
MP3 player!

Press and hold the GEMSTONE
FUN button on your MP3 player.

SURPRISE! With your GEMSTONE
FUN button, you can start creating
a voice recording right away! Just
speak or sing into the MIC
(microphone) on the bottom of your
MP3 player.

NOTE:
Please see pages 21-23 for more
information about voice recordings.

Barbie™ has another surprise for you! Included on your Petal MP3

Player™ are these four songs:
» Hope Has Wings
* Where'd You Get That

*BARBIE
« Style It Up

NOTE: These songs are protected and can't be deleted from the
MP3 player. The songs will only show up on the MP3 player, they
can't be downloaded via a computer.
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TROUBLESHOOTING GUIDE

If you experience a problem with this unit, check the chart below
before calling for service.

inserted.

SYMPTOM CAUSE SOLUTION
Unit will not Battery is low/empty. Recharge battery.
turn on.
Unit is not turned Press Play/Pause »11/Power
on. button to turn the unit on.
No sound. Headphones are not Insert headphones.

Volume is set too
low.

Raise the volume using the
Volume + button.

The MP3 or WMA files
are corrupted.

Download uncorrupted
files.

No files are in the
player.

Upload files to the unit as
described on pages 9-12.

The computer is not
recognizing the
player.

The player is
not securely connected.

Make sure player is
securely connected.

Computer is not
compatible.

Supported OS: Windows ME,
2000, XP, Vista or Mac 9.2X

WMA files with DRM
can’t playback.

Incorrect downloading
methods.

See page 12 to download
WMA files with DRM.

No buttons work.

The Hold feature is
activated.

Deactivate Hold feature as
described on page 14.

Unit needs to be reset
or firmware needs to be
updated.

Reset unit and/or
update firmware, see
page 29.

Unit acting erratically.

Unit needs to be reset
or firmware needs to be
updated.

Reset unit and/or
update firmware, see
page 29.
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EMERSON RADIO CORP.
LIMITED WARRANTY (Valid in the United States)

Emerson Radio Corp. warrants manufacturing defects in original material, including
original parts and workmanship, under normal use and conditions, for a period of ninety
(90) days from the date of original purchase in the U.S. With your dated proof of purchase,
we will provide repair service at no charge for labor and parts at an authorized Depot
Repair Facility, or replace the product in our discretion. For repair or replacement, pack
your unit in a padded box, enclose your check or money order payable to Emerson Radio
Corp. in the amount of $9.00 (not required by California residents) to cover shipping and
handling costs, and enclose a copy of your proof of purchase. Send your unit to:

Emerson Radio Corp.
5101 Statesman Drive
Irving, TX 75063

This warranty does not cover damage from negligence, misuse, abuse, accident, failure to
follow operating instructions, commercial use, rental, repairs by an unauthorized facility, or
products purchased, used, serviced or damaged outside of the United States.

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE
OTHER RIGHTS WHICH VARY FROM STATE TO STATE.
AU898M

The serial number of your system is located on a label on the bottom cabinet. Please take
a moment now to locate the serial number and write the number in the space provided
below. You may be asked to provide this number when calling for product service.

Model Number: BAR900
Serial Number:

(7 TO FIND THE LOCATION AND PHONE )
Zmersons | noveer o YoUur NEAREST seRvICE
SERVICE CENTER PERMITTED TO PERFORM
WARRANTY...
C CALL TOLL FREE: 1-800-695-0098 D)
N ?

FOR ADDITIONAL SET-UP OR OPERATING ASSISTANCE
PLEASE CALL:
1-800-898-9020

FOR CUSTOMER SERVICE, PLEASE WRITE TO:
Emerson Radio Corp.,
Consumer Affairs Dept.,
5101 Statesman Drive,
Irving, TX 75063.
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EMERSON® WARRANTY (Valid in Canada)
Consumer Electronics, Home Appliances and Home Office Products

Thank you for choosing EMERSON®!

SYNNEX Canada Limited gives the following express warranty to the original consumer purchaser or gift recipient for this
EMERSON product, when shipped in its original container and sold or distributed in Canada by SYNNEX Canada Limited
or by an Authorized EMERSON Dealer:

SYNNEX Canada Limited warrants that this product is free, under normal use and maintenance, from any defects in
material and workmanship. If any such defects should be found in this product within the applicable warranty period,
SYNNEX Canada Limited shall, at its option, repair or replace the product as specified herein. Replacement parts
furnished in connection with this warranty shall be warranted for a period equal to the unexpired portion of the original
equipment warranty.

This warranty shall not apply to:

a. Any defects caused or repairs required as a result of abusive operation, negligence, accident, improper
installation or inappropriate use as outlined in the owner’s manual.

b. Any EMERSON product tampered with, modified, adjusted or repaired by any party other than SYNNEX Canada
Limited or EMERSON's Authorized Service Centres.

c. Damage caused or repairs required as a result of the use with items not specified or approved by SYNNEX
Canada Limited, including but not limited to head cleaning tapes and chemical cleaning agents.

d. Any replacement of accessories, glassware, consumable or peripheral items required through normal use of the
product including but not limited to earphones, remote controls, AC adapters, batteries, temperature probe, stylus,
trays, filters, cables, paper, cabinet, cabinet parts, knobs, buttons, baskets, stands, shelves, cookware and
cooking utensils.

e. Any cosmetic damage to the surface or exterior that has been defaced or caused by normal wear and tear.

f.  Any damage caused by external or environmental conditions, including but not limited to transmission line/power
line voltage or liquid spillage.

g. Any product received without appropriate model, serial number and CSA /cUL /cULus /cETL /cETLus markings.

h. Any products used for rental or commercial purposes.

Any installation, setup and/or programming charges.

Should this EMERSON product fail to operate during the warranty period, warranty service may be obtained upon delivery
of the EMERSON product together with proof of purchase and a copy of this LIMITED WARRANTY statement to an
Authorized EMERSON Service Centre. This warranty constitutes the entire express warranty granted by SYNNEX
Canada Limited and no other dealer, service centre or their agent or employee is authorized to extend, enlarge or transfer
this warranty on behalf of SYNNEX Canada Limited. To the extent the law permits, SYNNEX Canada L|n1|ted disclaims
any and all liability for direct or indirect damages or losses or for any inci special or or loss
of profits resulting from a defect in material or workmanship relating to the product, including damages for the loss of time
or use of this EMERSON product or the loss of information. The purchaser will be responsible for any removal,
relnstallatlon transportatlon and insurance costs |ncurred Correctlon ofdefects |n the manner and period of time

herein, complete of all and of SYNNEX Canada Limited to the
purchaser with respect to the product and shall constitute full satisfaction of all claims, whether based on contract,
negligence, strict liability or otherwise.

CARRY-IN PARTS & LABOUR WARRANTY PERIODS:
* Audio Products: 1 Year (Remote Control, if applicable — 90 Days)
* Home Appliances: 1 Year
o Mlcrowave Magnetron parts only additional 3 Years
o R / Freezer Comp! or parts only, iti 4 years
* Home Office Products: 1 Year

To obtain the name and address of the nearest Authorized EMERSON Service Centre or for more information on this warranty
- visit www.emersonelectronics.ca
- mail your inquiry to: SYNNEX Canada Limited, EMERSON Cus(omer Service
Ronson Drive, Toronto, ON MOW 5Z9; o

- call toll free 1-800-663- 5954 Monday to Friday 9:00am — 5:00pm Eastem Standard Time.
08.2007
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